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Mitä on XBRL, inline XBRL ja 
XHTML
▪XBRL (eXtensible Business Reporting Language): on XML-
pohjainen merkintäkieli

▪XHTML (eXtensible Hypertext Markup Language): HTML:stä 
kehitetty verkkosivujen merkintäkieli, joka täyttää XML:n 
muotovaatimukset.

▪Inline XBRL: on laajennus XBRL 2.1 pohjastandardiin, joka
mahdollistaa raportoitavien tietojen esittämisen (X)HTML-
muodossa (XML:n sijaan)
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XBRL – metatiedon
ilmaisuvoima

<NetTurnover>
(XML skeema)

“KPL §3 2”
(Reference 
linkbase)

“Liikevaihto”, “Net 
turnover”

(Label linkbase)

“$Liikevaihto-
$Hankinnan ja

valmistuksen kulut = 
$Bruttokate”

(Calculation / Formula 
linkbase)

“Liittyy
Toimialaluokitus-
dimensio (data 

kuutiossa)”
(Definition linkbase)

“Ensimmäinen rivi
tuloslaskelmassa”

(Presentation / 
table linkbase)



XBRL-raportointi Suomessa

▪SBR-taksonomiaan pohjautuvat
▪ Inline XBRL-raportointi PRH:lle

▪Osakeyhtiöiden tilinpäätösraportointi 

▪ Säätiöiden tilinpäätöskokeilu meneillään

▪XBRL-raportointi kunnille ja niiden liikelaitoksille Kuntatalouden 
tietopalvelussa

▪XBRL-raportointi pankeille ja vakuutuslaitoksille 
(Finanssivalvonta)

▪inline XBRL tilinpäätösraportointi listayhtiöille (ESEF) 2021

https://www.valtiokonttori.fi/palvelu/kuntatalouden-tietopalvelu/
https://www.valtiokonttori.fi/palvelu/kuntatalouden-tietopalvelu/


Listattujen yritysten (Oyj) raportointi

▪ESMA:n (European Securities and Markets Authority) mandaatti kaikille
EU:n alueella toimiville listayhtiöille

▪ESEF (European Single Electronic Format)

▪Tavoitteet

▪ Harmonisoida talousraportointia

▪ Parantaa tiedon vertailukelposuutta

▪ Parantaa rahoitusmarkkinoille annettavan tiedon laatua

▪2020 päättyviltä tilikausilta kaikki tilinpäätökset inline XBRL muodossa 
(IFRS-taksonomia) 

▪Raportit toimitetaan ensisijaisesti Pörssiin (Nasdaq). Raportointia 
valvoo Finanssivalvonta

https://www.esma.europa.eu/policy-activities/corporate-disclosure/european-single-electronic-format
https://www.esma.europa.eu/policy-activities/corporate-disclosure/european-single-electronic-format


iXBRL – sekä ihmissilmin että 
kone-luettava 
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https://www.gleif.org/assets/components/xbrl-viewer/gleif-annual-report-2018-viewer.signed.signed.signed.signed.xhtml#f-ixv-0

https://www.gleif.org/assets/components/xbrl-viewer/gleif-annual-report-2018-viewer.signed.signed.signed.signed.xhtml#f-ixv-0
https://www.gleif.org/assets/components/xbrl-viewer/gleif-annual-report-2018-viewer.signed.signed.signed.signed.xhtml#f-ixv-0
https://www.gleif.org/assets/components/xbrl-viewer/gleif-annual-report-2018-viewer.signed.signed.signed.signed.xhtml#f-ixv-0
https://www.gleif.org/assets/components/xbrl-viewer/gleif-annual-report-2018-viewer.signed.signed.signed.signed.xhtml#f-ixv-0
https://www.gleif.org/assets/components/xbrl-viewer/gleif-annual-report-2018-viewer.signed.signed.signed.signed.xhtml#f-ixv-0
https://www.gleif.org/assets/components/xbrl-viewer/gleif-annual-report-2018-viewer.signed.signed.signed.signed.xhtml#f-ixv-0
https://www.gleif.org/assets/components/xbrl-viewer/gleif-annual-report-2018-viewer.signed.signed.signed.signed.xhtml#f-ixv-0
https://www.gleif.org/assets/components/xbrl-viewer/gleif-annual-report-2018-viewer.signed.signed.signed.signed.xhtml#f-ixv-0
https://www.gleif.org/assets/components/xbrl-viewer/gleif-annual-report-2018-viewer.signed.signed.signed.signed.xhtml#f-ixv-0
https://www.gleif.org/assets/components/xbrl-viewer/gleif-annual-report-2018-viewer.signed.signed.signed.signed.xhtml#f-ixv-0
https://www.gleif.org/assets/components/xbrl-viewer/gleif-annual-report-2018-viewer.signed.signed.signed.signed.xhtml#f-ixv-0
https://www.gleif.org/assets/components/xbrl-viewer/gleif-annual-report-2018-viewer.signed.signed.signed.signed.xhtml#f-ixv-0
https://www.gleif.org/assets/components/xbrl-viewer/gleif-annual-report-2018-viewer.signed.signed.signed.signed.xhtml#f-ixv-0
https://www.gleif.org/assets/components/xbrl-viewer/gleif-annual-report-2018-viewer.signed.signed.signed.signed.xhtml#f-ixv-0
https://www.gleif.org/assets/components/xbrl-viewer/gleif-annual-report-2018-viewer.signed.signed.signed.signed.xhtml#f-ixv-0


Inline XBRL – tekstieditorissa
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Taksonomiat
Muut (oy, kunnat, ..) Listayhtiöt (Oyj)

Ylläpito Valtiokonttori IFRS-säätiö / ESMA

Taksonomian jakelu Avoindata.fi / SBR 
taksonomia

ESMA

Pohjalla olevat lait ja
määritykset

Kirjanpitolaki
Kirjanpitoasetus
JHS-suositukset
Muut luokitukset ja
koodistot

IFRS-standardi

Tekniset kuvaukset European XBRL 
Taxonomy
Architecture

ESMA

https://www.valtiokonttori.fi/palvelu/talousraportoinnin-koodistot-ja-taksonomiat/
https://www.esma.europa.eu/policy-activities/corporate-disclosure/european-single-electronic-format
https://www.avoindata.fi/data/fi/dataset/sbr-taksonomia
https://www.avoindata.fi/data/fi/dataset/sbr-taksonomia
https://www.avoindata.fi/data/fi/dataset/sbr-taksonomia
https://www.esma.europa.eu/policy-activities/corporate-disclosure/european-single-electronic-format
ftp://ftp.cen.eu/CWA/CEN/XBRL/CWA_16744-3_2014.pdf
ftp://ftp.cen.eu/CWA/CEN/XBRL/CWA_16744-3_2014.pdf
ftp://ftp.cen.eu/CWA/CEN/XBRL/CWA_16744-3_2014.pdf
https://www.esma.europa.eu/policy-activities/corporate-disclosure/european-single-electronic-format


SBR-taksonomian
julkaisupaketin sisältö
▪Taksonomiapaketti (zip)

▪ Taksonomian tekniset tiedostot (skeemat ja linkbase-tiedostot

▪ META-INF-hakemiston, jossa on esim. Kaikkien
raportointikokonaisuuksien entrypoint-skeemojen sijainnit

▪DPM (data point model)-tietokanta

▪ Taksonomian sisältö SQLite-tietokannassa. Lisää DPM:stä tästä. 

▪Peruselementtimääritykset-excel

▪Versiomuutokset

▪Readme-tiedosto

https://eurofiling.info/portal/data-point-model/


SBR-taksonomian osakeyhtiöiden
tilinpäätöskokonaisuuden sisältö
Perustiedot

◦ Yrityksen nimi, tilikausi, …

Tuloslaskelma
◦ Asetuksen mukainen kaava, pienyrityksen- sekä mikroyrityksen kaava

◦ Näistä erikseen vielä kululaji- ja toimintkokohtaiset

Tase
◦ Asetuksen mukainen kaava, pienyrityksen- sekä mikroyrityksen kaava

Rahoituslaskelma
◦ Suora- ja epäsuora menetelmä

Liitetiedot
◦ Toistaiseksi kaikki liitetiedot annetaan tekstiblokkeina

◦ Esim. “Liitetiedot henkilöstöstä ja toimielinten jäsenistä”



=”interoperable.finland.fi”

SBR-taksonomian yhteys Suomi.fi-
määrityksiin

Suomi.fi alusta Taksonomian sisältö (DPM)

dictionary (sanasto)

frameworks 
(raportointikokonaisuudet)

Tietomallit

KoodistotSanastot

Yhteentoimi-
vuusalusta 
(suomi.fi)

https://yhteentoimiva.suomi.fi/fi/
https://yhteentoimiva.suomi.fi/fi/
https://yhteentoimiva.suomi.fi/fi/


Kehityksen tueksi
Muut (oy, kunnat, ..) Listayhtiöt (Oyj)

Opastus PRH / Valtiokonttori / XBRL 
Suomi
Taksonomia excelit
Kunnille lisäksi VK:n
julkaisemat muut
materiaalit

ESMA / Fiva / ESEF HUB
ESMA conformance suite

Esimerkkiaineistoja Avoindata.fi / SBR 
taksonomian
esimerkkiaineistot

ESMAn kenttätestit /  XBRL 
International

RECEiX-työkalu (Inline XBRL 
esimerkkiaineistojen
tuottaminen)

RECEiX SBR-taksonomian
mäppäyksillä (huom. Versio
28.3.2019)

RECEiX ESEF-mäppäyksillä

https://www.prh.fi/fi/tietoa_prhsta/projektit/ixbrl.html
https://www.valtiokonttori.fi/palvelu/talousraportoinnin-koodistot-ja-taksonomiat/#osakeyhtioiden-tilinpaatoksen-sbr-taksonomia
https://fi.xbrl.org/home/usein-kysyttyja-kysymyksia/
https://fi.xbrl.org/home/usein-kysyttyja-kysymyksia/
https://drive.google.com/open?id=19Bajc6mupIxNuVQSh6dhYUjkDwSClBKw
https://drive.google.com/open?id=19Bajc6mupIxNuVQSh6dhYUjkDwSClBKw
https://www.avoindata.fi/data/fi/dataset/sbr-taksonomia/resource/a6c0aa6d-f029-4094-94ca-637144d964de
https://www.avoindata.fi/data/fi/dataset/sbr-taksonomia/resource/a6c0aa6d-f029-4094-94ca-637144d964de
https://www.avoindata.fi/data/fi/dataset/sbr-taksonomia/resource/a6c0aa6d-f029-4094-94ca-637144d964de
https://www.avoindata.fi/data/fi/dataset/sbr-taksonomia/resource/a6c0aa6d-f029-4094-94ca-637144d964de
https://www.avoindata.fi/data/fi/dataset/sbr-taksonomia/resource/a6c0aa6d-f029-4094-94ca-637144d964de
https://www.avoindata.fi/data/fi/dataset/sbr-taksonomia/resource/a6c0aa6d-f029-4094-94ca-637144d964de
https://www.esma.europa.eu/policy-activities/corporate-disclosure/european-single-electronic-format
http://www.finanssivalvonta.fi/fi/Listayhtiolle/IFRS/ESEF_XBRL/Pages/Default.aspx
http://www.xbrleurope.org/?page_id=1235
https://www.esma.europa.eu/press-news/esma-news/esma-publishes-esef-conformance-suite
https://www.avoindata.fi/data/fi/dataset/sbr-taksonomian-esimerkkiaineistot
https://www.esma.europa.eu/field-test-esef
https://www.esma.europa.eu/field-test-esef
https://www.xbrl.org/the-standard/what/ixbrl/ixbrl-example/
https://www.xbrl.org/the-standard/what/ixbrl/ixbrl-example/
https://drive.google.com/open?id=1PCKA7cByonno-2z7p_Yv9XRXl4LmENiI
https://drive.google.com/open?id=1PCKA7cByonno-2z7p_Yv9XRXl4LmENiI
https://drive.google.com/open?id=1PCKA7cByonno-2z7p_Yv9XRXl4LmENiI
https://drive.google.com/open?id=1PCKA7cByonno-2z7p_Yv9XRXl4LmENiI
https://drive.google.com/open?id=1PCKA7cByonno-2z7p_Yv9XRXl4LmENiI
http://www.openfiling.info/ixbrl/


Miten saan tilinpäätökset
inline XBRL-muotoon?
▪Nykyisin: 
▪ suurin osa taloushallinnon järjestelmistä tulostaa PDF-

muodossa peruslaskelmat

▪ Yritykset / kirjanpitäjät editoivat wordissä muuta tekstiä

▪Jatkossa: 
▪ PDF-formaatin sijaan tallennetaan tiedot HTML-muodossa + 

järjestelmästä tulevat numeeriset tiedot (esim. “Aineelliset
hyödykkeet”) XBRL-tägien sisälle

▪ Muut “tägättävät” tiedot (esim. Liitetiedot) sekä tekstinä
liitettävät tiedot (esim. Tilintarkastuskertomus) tulisi myös
antaa samassa ohjelmassa, jotta iXBRL rakenne pysyy eheänä



Miten liitän tilintarkastuskertomuksen
tilinpäätökseen?

▪Tilintarkastuskertomus liitetään normaaliin tapaan tekstinä
tilinpäätöksen perään
▪Tilintarkastuskertomusta ei toistaiseksi tarvitse sisällyttää

rakenteisena

▪Esimerkkitiedosto tästä

▪Luonnos tilintarkastuskertomuksen taksonomiasta on 
julkaistu
▪Käyttöönottoa edistetään

▪Tutustu määritykseen tästä

https://drive.google.com/open?id=1pOHoJKZCqWEtFx01wypg0LAK2ol5KJQe
https://drive.google.com/open?id=1pOHoJKZCqWEtFx01wypg0LAK2ol5KJQe
https://drive.google.com/open?id=11ddNZvI8tYpjNzjBeaDe-27jput68th5


Mihin hyödynnän
taksonomiaa?
▪visualisoimaan raportoitavan tiedon sisällön käyttäjälle
ohjelmistossa

▪Tietokenttien määritykset

▪Tiedostojen validoinnissa (katso alempaa Arelle ohje)
▪Validoitavan dokumentin tulee viitata haluttuun

raportointikokonaisuuden entrypoint skeemaan, esim:

<ix:references>      <link:schemaRef xlink:type="simple"  
xlink:href="http://www.valtiokonttori.fi/fi/fr/xbrl/crr/fws/
stp/kpl-2016-12/2019-11-06/mod/stp_gaap_ind.xsd"/>   
</ix:references>



Mihin hyödynnän DPM-tietokantaa?

▪Sisältää saman sisällön kuin taksonomiakin, mutta
helpommin hyödennyttävässä muodossa

▪Pystyy helposti jäljittämään yhden taulukon solun
määrityksen takaisin koodistoista tuleviin
kohdennuksiin

▪Ei voi käyttää sellaisenaan validoinnissa valmiissa
työkaluissa



Mihin hyödynnän taksonomian
excel-visualisointia ja RECEiX-
työkalua?

Excel-visualisoinneista helpoin tapa ymmärtää
◦ mistä eri raportointikokonaisuudet sisältää

◦ Mistä raportoitavien tietokenttien määritykset muodostuu
(kohdistukset)

RECEiX-työkalulla
◦ helposti esimerkkiaineistoja

◦ Avoimen lähdekoodin (makro) hyödyntäminen omasa 
toteutuksessa

https://drive.google.com/open?id=19Bajc6mupIxNuVQSh6dhYUjkDwSClBKw
https://drive.google.com/open?id=19Bajc6mupIxNuVQSh6dhYUjkDwSClBKw
https://drive.google.com/open?id=19Bajc6mupIxNuVQSh6dhYUjkDwSClBKw


Taksonomian visualisointi
excelit - tulkinta

Ajankohdan kohdiste: 
tilikauden lopussa T-1 
(=edellisen tk:n lopussa) 
(RF-koodiston jäsen ‘x4’

Mittari: kirjanpitoarvo
(metrics-koodiston jäsen
‘mi53’

kirjanpidon koodi: 
Aineettomat hyödykkeet
(MC-koodiston jäsen
‘x551’



Miten tieto ilmaistaan inline XBRL-
rakenteessa? (vrt. edellinen kalvo)

Mittari ja kohdisteet

Raportoitava arvo ja 
sen esittämiseen
liittyvät tarkenteet



Inline XBRL-sisällölle ohjenuoria
▪Skriptit: ei suositeltavia

▪Viittaukset ulkopuolisiin tiedostoihin (kuvatiedostot, css-tyylisivut, 
skriptit jne.): ei suositeltavia

▪Tyylittelyt (css): suositeltavia (kunhan samassa dokumentissa)

▪Piilotettu sisältö (css): ei suositeltavia; kaikki tietosisältö näkyviin, 
XBRL-tägien sisään mieluiten

▪Kuvien sisällyttäminen: suositellaan sisällytettäväksi
binäärimuotoisena

16.10.2025 20



Etumerkkien käytöstä
▪Oletusarvoisesti kaikki luvut puhtaina lukuina ilman etumerkkejä. 
Elementin nimellä/määrityksellä ilmaistaan olettama kyseisen erän 
etumerkille (tuotot plussaa ja kulut miinusta). 

▪Ainoastaan jos kulu on kääntynyt tuotoksi tai toisinpäin -> miinusmerkki 
mukaan lukuun

▪”muutos”-tyyppiset erät ovat olettamalta aina taseen arvoa tai 
liiketulosta kasvattavia, jolloin luku raportoidaan positiivisena. 

Esim1. ”Liiketoiminnan muut kulut” ovat 100 €
◦ Arvo raportoidaan “100” (ei miinusta, koska olettama on kulu)

Esim2. ”Voitto (tappio) ennen satunnaisia eriä” on 500 € tappiollinen
◦ Arvo raportoidaan “-500” (olettama on voitto)

Esim 3. ”Aineelliset hyödykkeet” arvo tilikauden lopussa on 300 €
◦ Arvo raportoidaan “300” (ei mahdollisia taseen tilien etumerkkejä mukaan)

Esim 4. ”Antolainauksen muutokset + (-)”, antolainaus on pienentynyt tilikauden aikana 1000 €
◦ Arvo raportoidaan “-1000” (olettamana ilmaistu, että antolainaus kasvaa)

Esim 5. ”Suunnitelman mukaiset poistot”, poistoja tehty tilikauden aikana 800 €
◦ Arvo raportoidaan “800” (olettaman mukainen, ei miinusmerkkejä)

Esim 6. ”Toiminnan ja investointien rahavirta”, toiminnan ja investointien rahavirta on 500 € 
negatiivinen.

◦ Arvo raportoidaan ”-500” (Yleisolettama rahavirroista on positiivinen)  21



XBRL-spesifikaatiot
https://specifications.xbrl.org/specifications.html

◦ XBRL 2.1 spesifikaatio

◦ Tärkeimmät hyödynnettävät laajennukset:

◦ Dimensions 1.0

◦ Table linkbase 1.0

◦ Taxonomy Package 1.0

◦ Inline XBRL 1.1

https://specifications.xbrl.org/specifications.html
https://specifications.xbrl.org/work-product-index-group-base-spec-base-spec.html
https://specifications.xbrl.org/work-product-index-group-base-spec-base-spec.html
https://specifications.xbrl.org/work-product-index-group-base-spec-base-spec.html
https://specifications.xbrl.org/work-product-index-group-dimensions-dimensions.html
https://specifications.xbrl.org/work-product-index-group-dimensions-dimensions.html
https://specifications.xbrl.org/spec-group-index-table-linkbase.html
https://specifications.xbrl.org/spec-group-index-table-linkbase.html
https://specifications.xbrl.org/spec-group-index-table-linkbase.html
https://specifications.xbrl.org/spec-group-index-table-linkbase.html
https://specifications.xbrl.org/spec-group-index-taxonomy-packages.html
https://specifications.xbrl.org/spec-group-index-taxonomy-packages.html
https://specifications.xbrl.org/spec-group-index-inline-xbrl.html
https://specifications.xbrl.org/spec-group-index-inline-xbrl.html


Hyödyllisiä työkaluja kehittäjille
Arelle

◦ Open source työkalu XBRL-taksonomioille ja instanssidokumenteille (mm. 
validointi)

XML-kirjastot eri ohjelmistokielille

XBRL-työkalut

XBRL-Kehittäjien ohjeet

16.10.2025 23

https://www.nuagility.com/
https://www.xbrl.org/the-standard/how/tools-and-services/
https://www.xbrl.org/the-standard/how/tools-and-services/
https://www.xbrl.org/the-standard/how/tools-and-services/
https://www.xbrl.org/the-standard/how/getting-started-for-developers/
https://www.xbrl.org/the-standard/how/getting-started-for-developers/
https://www.xbrl.org/the-standard/how/getting-started-for-developers/
https://www.xbrl.org/the-standard/how/getting-started-for-developers/


Arellen käytön aloitus:
1. Asenna Arelle

2. Tallenna taksonomian alihakemistot (esim. www.valtiokonttori.fi) 
Arellen cache-sijaintiin valitsemalla tools > internet > manage cache

3. Avaa taksonomian entrypoint tiedosto taksonomian sisällön
katselemiseksi (File > Open File) 

..\www.valtiokonttori.fi\fi\fr\xbrl\crr\fws\oytp\kpl-2016-
12\2019-11-06\mod\oytp_gaap_ind.xsd 

4. Avaa jokin esimerkkiaineisto (File > Open File)

5. Validoi tiedosto (Tools > Validation > Validate), tulos näkyy alhaalla
viestilaatikossa

6. Arelle toimii myös komentoriviltä ajettuna!

http://arelle.org/
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